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Welcome to Asset Inventory 98!
Congratulations! You've just purchased Asset Inventory 98, the most versatile program ever designed to 
itemize, organize, and track all your personal and commercial assets. So whether you're a corporate 
manager transferring your surplus filing cabinets from Houston to the new Wisconsin branch office, a hair 
salon owner counting capes and towels, a volunteer keeping tabs on props and costumes for the local 
non-profit theater group, or even a homeowner insuring the (priceless!) Royal Doulton china Aunt Mildred 
shipped all the way from England, Asset Inventory 98 gives you a fast, simple way to find that place for 
everything...and then keep everything in its place!

Special features built right into the program make Asset Inventory 98 easy to learn and even easier to 
use.    Following this step-by-step manual, you'll quickly master the basic tools you need to create the 
custom database that's right for you. When you're ready to move on, clear, jargon-free instructions teach 
you the keystrokes that put your new database to work. Minutes later, you're the expert! At your 
command, the Asset Inventory 98 program will:                   

· Employ the Wizard to instantly create new asset databases
· Track your possessions by their Location or Category
· Sort your property into Taxable and Non-taxable classes
· Scan and store identifying pictures of your valuables
· Total the value of your household goods 
· Print customized reports suitable for business valuation, property tax declaration, and 

insurance policies and claims
· Copy your inventory to backup discs
· And more! 

By choosing Asset Inventory 98, you did something besides discover a great new way to track and 
manage your assets.    You chose to protect yourself, your business, your home, and your family from the 
pain and expense of material loss, theft, or damage. We're proud that our product will be of service to you 
in this endeavor. 

Please read the following articles carefully before proceeding:

· End User Licensing Agreement

Windows, Windows 95, and Windows NT are registered trademarks of the Microsoft Corporation. The use of these terms is not 
intended to convey endorsement or other affiliation.



Features/Capabilities
Asset Inventory 98 helps you easily track and manage your personal and professional assets by providing 
the following advanced features and capabilities:

· A 32-bit Windows environment (built to run in Windows 95 or Windows NT)
· The user-friendly look and feel of Windows 95 Explorer 
· Full Windows functionality, including drag & drop features
· Distinctive customizing options for locations, sub-locations, and categories
· Versatile icon selection, offering hundreds of customizable icons plus the option of adding your 

own
· Database Wizards and Plugin Template support
· TWAIN Scanner support for scanning pictures of your items
· Exceptionally flexible report options for customized reporting
· Automatic database backups and reminders



System Requirements
To offer the user the friendly look and comfortable feel of a familiar environment, Asset Inventory 98 has 
been specifically designed to run under the 32-bit operating system provided by Windows. To install Asset 
Inventory 98, you will need:

· The Windows 95 or    Microsoft Windows NT Workstation 4.0 operating system or higher 
· 8 MB of memory (16 MB recommended) for Windows 95 or 16 MB of memory (32 MB 

recommended) for Windows NT Workstation
· A CD-ROM drive or a 3.5-inch high-density floppy drive
· A hard disk with 20 MB free space
· A VGA or higher-resolution monitor (Super VGA recommended)
· A mouse (or similar pointing device)

OPTIONAL DEVICES which will enhance the features of Asset Inventory 98:

· A graphics compatible printer
· A TWAIN compatible scanner



Inventory Explorer
Since the easiest way to learn any new program is right from the beginning, this manual starts from the 
moment you open Asset Inventory 98 for the first time. After Asset Inventory loads the necessary 
preferences, the following window immediately appears on your screen. 

This manual will address each of Asset Inventory's features as you encounter them, but if you need 
information right away, the Inventory Assistant (shown below) lets you reference Help the minute you 
open the program. Simply click the Inventory Assistant anytime you need help.

Inventory Assistant

Your Inventory Explorer (below) is the user interface of Asset Inventory 98.    Here, you'll find all the 
basic features that let you move around in the program. Of course, the more familiar you become with 
these features, the faster you'll be able to click through your inventories.

Inventory Explorer



In the next few pages, this manual will take you through a guided tour of the Inventory Explorer, as your 
introduction to operating the: 

·       Menu Bar
·       Toolbar
·       Location/Category Tree
·       Listview

As we browse through each of these features, we'll probably take a few breaks along the way to let you in 
on important information you'll need to understand the special aspects of the program. 



Menu Bar

As you can see, the Menu Bar offers a variety of major menus , such as File, View, and Tools. Each 
major menu includes available options, which launch different program features.    To view a list of the 
options for a menu, all you need to do is click the desired menu. As shown in the above example, the 
clicked menu instantly displays all its options, some of which may include detailed sub-options.

Every feature available to the program is found somewhere in the Menu Bar. Through frequent use, you'll 
soon have each feature's location memorized, but for now, we suggest that you merely browse through 
the Menu Bar to gain a general understanding of the available options. Any time you have questions or 
need further information, you can always click Help on the right of the Menu Bar.



Toolbar
Differing from the Menu Bar, the Toolbar, pictured below, provides quick access to commonly used 
program commands, rather than every program feature.    Designed for speed, the Toolbar lets you zip 
through those operations you use all the time, such as opening files, adding new inventory items, and 
editing lists. Simply click the Toolbar option you want to select!

On the right side of the Toolbar, you'll find your Asset Inventory 98 Assistant. Like the Toolbar itself, the 
Assistant can offer you quick reference on common operations, but also gives you full access to the Asset 
Inventory Help resources directly from the Toolbar. 

An additional handy feature of the Toolbar that may be of particular interest to our left-handed users: the 
Toolbar can be moved and/or "Docked" to the top, left, or right side of the program screen. 

To Relocate the Toolbar:

1.    Click the vertical bars shown below and hold the button down on your pointer 
2.    Drag the Toolbar to the spot that's most convenient for you

Asset Inventory 98 can be configured to save the layout position you give your Toolbar so that the Toolbar 
appears in the same place every time you open Asset Inventory 98. (See Save Toolbar Layout on Exit 
under Asset Inventory 98 Options.)



Locations, Categories, and Items
Since almost every Asset Inventory 98 operation deals with a Location, a Category, or an Item in one 
way or another, it's a safe bet you'll need to know what these terms mean before you get too far along.

· Location
Pretty much, any physical place you use for storing any physical thing qualifies as a 
Location.    Offices, kitchens, motorhomes,and basements would all be types of the more 
typical Locations that spring to mind, but if you stash all your Christmas ornaments in 
your dad's old government-issued trunk, "Army Footlocker" could turn out to be as good a 
Location as any. In fact, in this case, your Location is actually an Item that is allowed to 
contain other items. 

· Category
If the very word Category takes you back to those warm fuzzy memories of playing 
games in the backseat of the car during long family roadtrips, you've got the basic idea! 
In Asset Inventory 98, your Categories are the generic classes in your inventory that 
loosely define the individual Items. Once you've classified an Item as belonging to a 
particular Category, that Item will always appear under that Category, no matter where 
the Item is physically stored.

· Item
It's tough to think of anything that couldn't be considered an inventory Item! The potted 
palms in your lobby are items. The hammers in your toolbox are items. Sheets are Items, 
copiers are Items...let's put it this way; any physical thing that isn't literally nailed down 
can reasonably be regarded as an inventory Item. 



Location/Category Tree
As you begin creating your inventory database, you'll designate Locations and Categories for your 
possessions. As soon as you generate them, each of these Locations and Categories will appear on the 
Location/Category Tree, as seen below. 

In the example on the left, the Location/Category Tree is set to show the Locations View. 

Clicking on the Categories bar at the bottom of the Treeview changes the view to show all the various 
Categories you've selected, as seen in the example on the right. 

Clicking the Locations bar at the top of the Treeview switches the view back. (Other techniques for 
changing the Treeview are available and will be presented as you progress through this manual.) 

  

As the Location/Category Tree displays only your major Locations/Categories, not the Items of each, 
the feature essentially offers a structure-only image of your inventory, allowing you to view the methods of 
organization which serve as the framework for cataloging your inventory items.

This structure-only design of the Tree offers you a convenient way to rearrange large blocks of your 
inventory without having to shift around individual items. 

For example, let's say your oldest child has just married and transferred to Chicago, and you've moved all 
the contents of his room into the storage area in your garage. Using the Drag & Drop option, you can 
literally pick up "Kid's Room" from your "Home" Location on the Tree, drag it down to your "Garage", and 
then park it right behind the Dodge. Any time you go into the "Garage", "Kid's Room" and all its contents 
will be there...broken tennis rackets, torn sweatshirts, and all. 

And speaking of that Drag & Drop Option...



Drag & Drop
As you continue to explore the range of Asset Inventory 98 operations, you'll frequently encounter Drag & 
Drop techniques specifically designed to make your life a little easier. Instead of hopping in and out of 
menu lists to perform an activity, you can often save yourself a couple of steps. 

To Drag and Drop an object:

1.      Click on the object you want to move
2.      Hold that object by keeping your finger pressed on the pointer button
3.      Drag the object to the desired location by moving your pointer, and
4.      Drop the object into place by releasing the pointer button

The Asset Inventory 98 activities which boast Drag & Drop features are too numerous to mention here, so 
you'll find each Drag & Drop method available to a specific operation explained in detail as you move on 
to the instructions for that operation. Right now, we return you to your screen for a sneak peek at the 
Listview. 



Listview
Just to the right of your Location/Category Tree, you'll see a Listview window like the one shown below. 
As the extremely clever name of this feature suggests, the Listview displays a view of every individual 
Item listed under each Location/Category of your inventory. 

So if, for example, you find yourself in charge of organizing your church's annual charity bazaar, the 
Listview of a Location can show you just which boxes of donations have been stored in whose 
volunteer's graciously offered basement. The Listview of the Category can tell you precisely how many 
of those boxes still contain the four dozen lavender crocheted ski boot covers that didn't exactly sell like 
hot cakes last year. (Or, come to think of it, the year before that.) 

But there's more to the Listview than first meets the eye, so keep reading! Once you start creating your 
inventory database, you'll come across several nifty Listview shortcuts that shave hours off the time you 
spend paying attention to details.



Asset Inventory 98 Options
Everyone has personal preferences when it comes to program options, so before you go on, you might 
want to take a few moments to tell Asset Inventory 98 how you like things to work. 

Under Tools on the Menu Bar, click Options. The window below will appear on your screen. 

The Asset Inventory 98 Options Window lets you control every automatic operation of the program. 
To indicate your choice, click the box to the left of a selection. A dot or checkmark materializes in the 
box to show you which method the program will use in the future. Any time you change your mind, simply 
click another box to change the option. 

If you're not sure yet which option would best suit your tastes, the descriptions below can help you pick a 
favorite flavor.
  
Inventory Explorer Options

If you select:

Don't ask for Confirmation on move or delete
This requests that the program not double check with you to be absolutely certain you 
want to relocate an item or get rid of it altogether.

Double-Click to open an item (Single-Click to select)
This specifies that you want to single-click an Item to select it, and double-click an Item to 
open it. As this is the normal windows explorer behavior, it may be the style most familiar 
to most users.

Single-Click to open an item (Point to select)
This states that you like to position the cursor over an Item to select it and single-click the 
Item to open it. Internet users addicted to the typical behavior of modern web browsers 
usually head this-a-way. 

Toolbar Options



If you select:

Save Toolbar Layout on exit
The click here tells Asset Inventory 98 to remember exactly how you docked your Toolbar 
when the application is closed. The next time Asset Inventory 98 opens, you'll find your 
Toolbar right where you left it. (And don't you wish you could say the same for your car 
keys?)

Reset Toolbar Layout
Clicking this button informs Asset Inventory 98 that it's okay to delete the saved Toolbar 
position you last used and reset the Toolbar to its original setting. When you next open 
the program, your Toolbar turns up under the Menu Bar as if it's been there all the time.

Other Options

If you select:

Automatically open last used database on startup
Checkmarking this box directs Asset Inventory 98 to automatically open your most 
recently used database every time Asset Inventory 98 is started. If you're in the middle of 
creating a database or planning to work with the same database frequently, this option 
gets you back on task fast! 

Automatically Prompt for backup on exit
We'll warn you now: a click on this one gives Asset Inventory 98 permission to nag you to 
backup your database whenever you try to exit. An obnoxious little option and an 
absolute lifesaver for anyone who ever forgot to backup a huge, critically important, finally 
perfect file...and lived to start from scratch the next day.

Automatically Backup to:
This little time saver sets the default folder used to store backup sets. You can type in 
your selection, choose Asset Inventory 98's default, or leisurely browse through the 
possibilities.

Use the Inventory Assistant:
Checking this square will request that the program call up the Inventory Assistant for 
confirmation dialogs.

Do not show the Inventory Assistant:
If you prefer to work without interruptions, a checkmark on this one asks the Inventory 
Assistant to politely excuse himself when Asset Inventory starts and be quiet until you 
choose to invite him back..



Deleted Items 
It's a fact of life: the more your inventory changes, the more your inventory changes! Maybe the Powers 
That Be in your Boston Headquarters axe the San Francisco project office. Or your restaurant equipment 
supplier quits making those cute little salt shakers shaped like artichokes. You sell your 21' power boat to 
your brother-in-law (a cash-only transaction), haul your exercise bike to the thrift store (after removing the 
laundry from the handles), and burn, yes, outright burn that orange and brown plaid couch with the foam 
puffing out of various cat-induced rips in the upholstery (thereby kicking off a ceremonial backyard bonfire 
during which even the neighbors cheer).

For whatever reason, Locations, Categories, and Items you couldn't live without yesterday become 
history today. So Asset Inventory 98 offers you several ways to get rid of stuff you don't want anymore.

To Delete Singular Locations, Categories, or Items:

From the Menu

1.      Set your Treeview to the Location/Category mode that displays the Location, Category, 
or Item you wish to delete

2.      Click your selection for deletion
3.      Open Inventory on the Menu Bar
4.      Click Delete 

From the Toolbar

1.      Set your Treeview to the Location/Category mode that displays the Location, Category, 
or Item you wish to delete

2.      Click your selection for deletion
3.      Click Delete on the Toolbar 

With The Drag & Drop 

1.      Set your Treeview to the Location/Category mode that displays the Location, Category, 
or Item you wish to delete

2.      Click an individual object for deletion, or highlight multiple deletions using one of the 
techniques below

3.      Hold the button down on your pointer
4.      Drag your choice to the Deleted Items Trash Can at the bottom of the Treeview
5.      Drop your choice by releasing your pointer button

At this point, no matter which method you use, Asset Inventory 98 will ask if you truly want to delete that 
selection, and waits for your response before actually deleting it. 

In Step 2 of each of the above deletion methods, you can select multiple Locations, or Items for 
deletion by using the following different highlighting techniques:

To Delete Multiple Locations or Items:

· Select groups of objects that are next to each other by holding down the mouse button and 
dragging a rectangle around the objects you want to select

· Select blocks of lists by clicking the first selection, pressing the Shift Key, then clicking 
the last deletion selection in the block

 
· Choose several individual deletion selections from a list by holding the Control Key and 

clicking each object you want to select



· Delete all objects in a list by clicking Select All under View on the Menu Bar

A Few Words about Deletions...

You must remove all Items from a Category before the program will allow you to delete it. And be 
forewarned: deleted Categories are deleted permanently.

Deleted Items and Locations, on the other hand, remain in the Deleted Items Trash Can until you 
empty it. To take out the trash, merely click on the Trash Can to view all the Items and Locations you've 
thrown in there. Click on the Item or Location you'd like to permanently delete, and Asset Inventory 98 
will present you with a window that details the specifics of that Item and/or Location. From this window, 
you may choose to permanently delete the Item or Location, or restore it to its original Location or 
Category. 

To Restore Deleted Locations and Items

1.      Click on the Trash Can to view the list of deleted objects
2.      Click individual Items or Locations you wish to restore 

OR 
Select multiple objects using the highlighting methods above

            OR 
Choose Select All from the View menu 

3.      Double-click the Item or Location to view its description, and select Restore
            OR

Right-click on the Item or Location and select Restore from the drop down menu

If the original Location no longer exists for Items or Locations you want to restore, Asset Inventory will 
place these in a Location called Restored Items/Locations so that you can retrieve them when you're 
ready to put them in new places. 

When you close the program, Asset Inventory 98 will notify you of any Deleted Items remaining in the 
trash can, just in case you want to double check before permanently tossing them.



Beginning A Database
In Asset Inventory 98, all databases are created equal, so although your actual inventory may eventually 
involve cataloging artwork in your city's museum, tracking garter display racks in your bridal shop, or 
itemizing heirloom antiques for your insurance update, the first step in the database set up process is 
always the same. At this stage, you need to know all the different techniques you can use: 

To Create a New Database:

From the Menu

1.      Open the File menu
2.      Choose New Database

With the Mouse

1.     Press the New Database button on the toolbar

With a Keystroke

1.     Press Ctrl+N

Any one of the above actions will command the Choose Template Window to appear:

In the second stage of the database setup process, you must select a template for your database. The 
Choose Template feature offers you a variety of Template choices:

· Select a Sample Database for a ready made Inventory designed to meet the typical set-up 
inventory needs for homes or businesses.

 
· Choose the Blank Database to ask Asset Inventory 98 to pull up a completely empty template 

that lets you design every aspect of your inventory from the ground up. 

· Click the Database Wizard for the best of both worlds: basic inventory design formats 
combined with step-by-step instructions to walk you through the creation of a personalized 
database.

(A short description of each Template appears at the bottom of the dialog box, and more Template options 
are on the way! The design crew at Graffiti Software is already generating new samples, and you can 
check out the latest developments on our website at http://www.graffitisoft.com/support/)



To Select a Database:

1.      Highlight your template selection by clicking it once
2.      Press the OK button

OR

1.      Double Click your selection

 Moving On...

Choosing a Template catapults you right to Working with Database Templates, Step 1. 



Step 1 - Naming A Database
Presto! Your selection of any one of the Templates instantly conjures up this first window, which merely 
requests that you:

1.      Give your new database a "proper" filename under which to save your information
2.      Click Save

 

A Word about Naming Databases . . .

In fashion circles, less is more. In database names, less is rarely enough. Abbreviations that made a 
world of sense when you first typed them in somehow turn into gobbledygook when you try to read them 
three weeks later.

In order to make it as easy as possible for you to find documents, Asset Inventory 98 allows you to use 
long, descriptive file names. The complete path to the file, including the drive letter, server name, folder 
path, and file name, can contain up to 255 characters!

Keep in mind, however, that file names cannot include any of the following characters: forward slash (/), 
backslash (\), greater than sign (>), less than sign (<), asterisk (*), period (.), question mark (?), quotation 
mark ("), pipe symbol (|), colon (:), or semicolon (;).

To give you a few examples of some "proper" filenames:

C:\Asset Inventory 98\My New Database.pid
\\adifferentmachine\sharename\directory\filename

Another Word about Naming Databases...

Asset Inventory 98 provides a default name called My Inventory for new databases. Be sure to save any 
new database under a different name! As all new databases are titled My Inventory until you change 
them, you could accidentally save the small My Inventory database you just started over the huge My 
Inventory database you just completed, because they each possess the same default name. 

The Last Word on Naming Databases:

You don't need to worry about specifying the 3 letter extension (.pid) of a name. Asset Inventory 
98 happily does this for you.

Moving On...

Realizing that you may have to close your inventory before you finish it, we figure this is as good a time 



as any to shuffle over to Step 1 and a Half, which teaches you how to open the database you just made. 



Step 1 and a Half - Opening A Database
A brand-new database is like a brand-new puppy; after you figure out what to name it, you want it to come 
when it's called. You can whistle up any database in your files by using either of the following techniques: 

To Open an Existing Database:

From the Menu

1.      Open the File menu
2.      Choose Open Database
3.      Click the database you want from the list

With the Mouse

1.      Press the Open Database button on the Toolbar
2.      Click the database you want from the list

Remember, Asset Inventory 98 will Automatically open last used database on startup if that's what 
you'd like. (To review that feature, see Asset Inventory 98 Options.)

Moving On...

If you asked the Wizard to guide you through the design of your inventory, you'll now want to head 
straight for Step 2 to discover the secrets of the Database Wizard. 

If you figured you could get to Kansas without a trip to the Emerald City, and therefore chose either the 
Sample or    Blank Database, give the yellow brick road a miss in favor of the short detour offered in 
Step 1 and Three Quarters. 



Step 1 and Three Quarters - For Sample or Blank 
Database Users
As soon as a Sample or Blank Database is given a name, the Wizard presents you with the rather nosy 
question on the screen below. 

 
Rude though it is to pry, the program does require a response, as your selection
sets the default for Taxable/Non-taxable classes of inventory...an accounting must for businesses! 

If you select:

Home
New Items and Locations created in databases designated for home use will default to the Non-
Taxable classification. 

Business
New Items and Locations created in databases designated for business use will default to the 
Taxable classification.

Please note that these are only default settings. As you enter the specifics of your inventory, you can 
always change the classification of any Location, Category, or Item. 

Moving On...

All Sample and Blank Database users can now leapfrog Step 2 and hop on to Step 3 - Up Close and 
Personal.



Step 2 - The Wizard's Little Secret
After saving your database file under its new name, the Wizard will pop up the dialog window below. As if 
by magic, the information you type into each box allows the Wizard to construct the layout elements that 
organize your inventory. 

For this example, let's assume you wish to design an inventory to track your personal assets. You'll 
generate this design by entering information in the various fields of this window. 

1)      Locations:

These fields specify the components of your Location/Category Tree. 

Buildings
The number you type in this box tells the Wizard how many buildings to assign the inventory. 
Since the Wizard allows you up to eight different Buildings, you could include your permanent 
residence, your townhome in Arizona, the condo in Aspen, and your chalet in the Alps. 

Rooms
You may designate up to eight rooms for each of your Locations. If one of your Locations, such as 
an apartment or lake cabin, has fewer than eight rooms, you can change this information when 
you customize.

Automobiles
While some users want to keep their cars in a Location named Garage,    others appreciate 
having a separate area to keep tabs on company vehicles, rental cars, or leased transportation. 
Eight personalized spots to accommodate your fleet... Sorry, valet parking not included! 

 
Other Locations
Barns, campers, storage units, greenhouses, guest bungalows    - all of these qualify as examples 
of the eight Other Locations you can place in your database. 

2)      Database will be used for:

This selection sets the default for Taxable/Non-taxable classes.

Home
New Items and Locations created in databases designated for home use will default to Non-
Taxable. 



Business
New Items and Locations created in databases designated for business use will default to 
Taxable.

3)      Categories:

Pianos and dishes and wine racks, oh my! You'll want to invent Categories for all types of things, 
so go ahead and pick a number, any number. Don't worry if you think of dozens more Categories 
later...you can always customize in Asset Inventory 98.

One Very Important Note... 

The Wizard will use the data you provide in the above fields to create the initial structure of your 
database. After this initial design work has been completed, you can fully customize your database, 
adding a virtually unlimited number of Locations, Categories, and Items, all of which can be edited, 
moved or even deleted to suit your needs. 

Moving On...

Your database setup is almost there! You can now click your heels three times and fly to Step 3 - Up 
Close and Personal.



Step 3 - Up Close and Personal
Wrapping up the creation of your Template, the dialog window below appears to ask you to say a few 
words about yourself.

Personal/Company Information

After you fill in the blanks, this information will be displayed on all your printed Inventory reports until you 
choose to revise it. 

To Retrieve the Personal/Company Information Form:

1.      Click Tools
2.      Select Database Tools from the menu
3.      Click Personal/Company Information

Moving On...

Whether you started with a Sample Home Database, a Blank Database, or the Database Wizard, the 
initial format for your inventory is a done deal!      To start loading information into this first database, sprint 
directly to Adding Stuff to Your Database.



Adding a Location
Even though the Sample Database, the Blank Database and Database Wizard templates function 
differently, every Asset Inventory 98 user reaches this point prepared to:

· Designate original Locations in an empty database

      AND/OR

· Add new Locations to the ones already created by Sample or Wizard databases

Luckily, you only need one set of instructions, because both these activities employ exactly the same 
methods:

To Add a Location 

From the Menu

1.      Select Inventory on the Menu Bar
2.      Click Add New
3.      Select Location from the options

From the Listview 

1.      Right-Click in the Listview 
2.      Click Add New
3.      Select Location from the options

With the Mouse

1.      Click Location on the Toolbar

With a Keystroke

1.      Press Ctrl+L

No matter which method you use to call it forth, the Add New Location Form below appears on your 
screen. 



Tab Views

The General Tab 
The form presented in the General Tab View contains spaces for all the basic information 
concerning a Location.    Because a Location can be any place that holds items in your inventory, 
many of the Locations you generate won't require or even possess all the possible information 
you could enter in these fields, so not every field in the form needs to be filled.    For instance, 
your bedroom naturally won't have a serial number, but your motorhome just as naturally will. 

(Sometimes, an Item will actually function as a Location. An explanation of this situation appears 
in the chapter titled Locations, Categories, and Items.)

The Notes Tab
Perhaps you want to remember the name of the real estate agent who sold you your house, or 
make a list of all the improvements you've added to your camper. Click this tab to pull up an 
ingenious post-it area for any kind of notes or other tidbits of information you need to jot down 
concerning your Location.

The Photo Tab
Click this tab for direct access to the Photo Editor , which helps you scan and store a photo of the 
Location. (Certain accessory devices are required to use this feature. Check the Photo Editor 
section for details.) After you scan a snapshot of your Location, you'll find its picture under this 
tab. 

Completing the General Form

In the interests of giving you much more detail than you ever wanted to know, we've provided descriptions 
of each field in the list below. However, if the prospect of matching little numbered fields with their 
correspondingly numbered descriptions does not give you the thrill of your life, use this easy shortcut:

1.      Select Help from the Form Menu
2.      Click the What's This? option, and a question mark will materialize to the right of your cursor



3.      Use the What's This? cursor to click the Field you would like identified, 
          and a description of the field will pop up

Description of Fields on the Add New Location Form

To enter information into any of these fields:

1.      Click the field to place the cursor inside the field
2.      Type in the data

1)      Name of this Location:
This field holds the name of the Location.

2)      Description:
This space contains your description of the Location, so you can include specifics such as 
architectural styles or property lot sizes.

3)      Serial Number:
This area holds the serial number, if one exists, for the Location.

4)      Quantity:
This field is not available for Locations.

5)      Manufacturer:
This field retains the name of the company or organization that manufactured the Location, such 
as "Sunshine Solarium Structures", "Reggie's RV Engineering", or "Ford". 

6)      Model:
This field allows you to specify the model of any Location, such as "Sunshine Spa Deluxe A-5" or 
"1996 Mustang 5.0 GT".

7)      Extra Fields 1 and 2:
Whatever you want! These fields can be renamed or customized to hold any data you feel 
deserves its own field in the database. (To make your changes, select Database Tools from the 
Tools menu.)

8)      Purchase Price:
This slot lists the price you originally paid for the Location. 

9)      Present Value:
This field stores the Market Value or replacement cost of the Location. 

10)      Taxable/Non-Taxable:
Used mainly for business databases, these designations can be modified to flag Locations as 
Taxable or Non-Taxable for report and accounting purposes. (The default setting for a particular 
database is selected during the creation of the template and hinges on whether the database was 
originally designed    for "Home" or "Business" use.) 

11)    Purchased From:
This field gives you room to identify the store, person, or entity from which/whom you purchased 
the Location.

12)      Purchase Location:
The city, state, and/or country of purchase; the data you place here can be used for anything from 
registration requirements to equipment inquiries.



13)      Date of Purchase:
The date you purchased the Location, which can become a critical factor in insurance claims or 
warranty limits. (Clicking the button of the field calls up a calendar to let you select the date.)

14)      Original Invoice #:
The invoice number allocated to the Location at the time of purchase: often a necessary proof of 
purchase in insurance claims or warranty verifications.

15)      Category:
The Category in which you consider that Location a member. For example, your "London Flat" 
Location could fall into the "Real Estate Abroad" Category. 

Essentially, you can create every one of your database Categories in this field. To assign a 
Category to a Location, select one of the Categories you've already created from the roll-down list 
of this field or click the Add Category button to make a new one.

16)      Location Tree:
Presenting a list of all the Locations you've created, this window makes it easy for you to instantly 
place the new Location in the tree where you want it. If the list doesn't include the Location you'd 
like to specify, you can create a new Location directly from the form with the Add Location 
Button.

Button Options

The buttons on the Add a Location Form make it easy for you to perform operations directly from the 
form.

Add Category Button:
A click on this button will call up the Add New Category Form, so that you can create a new 
Category the minute you need one, right from the Add New Location Form.

Add Location Button:
You can actually create other new Locations even as you develop one on the Add New 
Location Form. Clicking this button allows you to name a new Location and place it where you'd 
like it to reside in the Location Tree. 

Display Icon Button:
Clicking this button loads the Icon Browser . (The Icon Browser feature invites you to select or 
change the Icon which, representing your Location, is then displayed in the Inventory Explorer. 
See the Icon Browser section for complete instructions.) 

Save Button:
A click on this tells the program to store all the Location information you've provided, including the 
icon and photo. Your new Location is added to your Treeview, ready and waiting to be filled with 
Items!

Cancel Button:
Press here to cancel the Add New Location operation any time you wish.

Right About Now...

Your Location Treeview is beginning to look something like this:



Moving On...

With your Locations and Categories branching out on your Treeview, it's time you...what? You say you 
just remembered of another Category you absolutely, positively have to have? Don't panic! The info you 
need is coming right up in Adding a Category. 



Adding a Category
Especially in commercial and business inventories, Categories for assets such as office furniture, 
computer stations, or industrial equipment can change faster than you can say, "Backorder." So Asset 
Inventory 98 gives you a variety of ways:

To Add a Category:

From the Menu

1.      Select Inventory on the Menu Bar
2.      Click Add New
3.      Select Category from the options

From the Listview 

1.      Right-Click in the Listview 
2.      Click Add New
3.      Select Category from the options

With the Mouse

1.      Click Category on the Toolbar

With a Keystroke

1.      Press Ctrl+A

Any method you prefer will call the Add New Category Form below to your screen:

Clicking the What's This? button allows you to click anything in the window with your cursor for a short 
description of that object. To fill in the blanks, click the desired field and merely type your information in. If 
you'd like to see an assortment of the icons you can give your new Category, just click the Change Icon 
button. If it suddenly occurs to you that you really didn't need this Category after all, hit the Cancel button 
to return to the screen you left. Click Ok, and your new Category is added to your Treeview.

Right about Now...

Your Category Treeview is beginning to look something like this:



Moving On...

To details, details! At last, we come to the nitty-gritty heart of any Inventory: every single itsy-bitsy teeny-
weeny little Item! But don't sweat the small stuff!    Just jump to the instructions in the next section,    
Adding an Item. 



Adding an Item
We can't pretend that adding individual Items to your inventory won't take you some time, but we can say 
Asset Inventory 98 makes short work of the job. So we're ready when you are:

To Add an Item:

From the Menu

1.      Select Inventory on the Menu Bar
2.      Click Add New
3.      Select Item from the options

From the Listview 

1.      Right-Click in the Listview 
2.      Click Add New
3.      Select Item from the options

With the Mouse

1.      Click Item on the Toolbar

With a Keystroke

1.      Press Ctrl+I

The Add Inventory Item Form below will appear on your screen:

Tab Views

The General Tab 
The form presented in the General Tab View contains spaces for all the basic information 



concerning an Item. Many users choose to be extremely detailed in their approach to Items, not 
only thoroughly filling out each field in the form but also taking care to ensure that every Home or 
Business Item they possess has been accounted for within their Inventories.

That's precisely the approach we encourage you to take toward using this program. Because 
every item you own, no matter how insignificant it may seem, may someday need to be replaced 
in case of damage or loss. So as you enter big ticket items such as couches, laptops, televisions, 
and stoves, look over the little things that are so easy to overlook; the bathroom waste cans, the 
mini-blinds, pencil sharpeners, and coffee cups. As the saying goes, it's the little things that count. 

(Once again, it's possible for an Item to actually function as a Location. An explanation of this 
situation appears in the chapter titled Locations, Categories, and Items.)

The Notes Tab
This area stores a handy scratch pad for comments or remarks concerning an Item, from 
reminders to repair the loose handles on a dresser to the name of the color chip of its paint. Any 
special information you want to add concerning an Item can be written here. 

The Photo Tab
Click this tab for direct access to the Photo Editor , which helps you scan and store identifying 
photos of your Items. (Certain accessory devices are required to use this feature. Check the 
Photo Editor section for details.) After you scan a snapshot of your Item, you'll find the picture 
under this tab. 

Description of Fields on the Add Inventory Item Form

As you probably already noticed, the Add Inventory Item Form is remarkably similar to the Add a 
Location Form, but there are some important differences worth checking into. And remember, to get 
help, you can always take the shortcut:

1.      Select Help from the Form Menu
2.      Click the What's This? option, and a question mark will materialize to the right of your    

cursor
3.      Use the What's This? cursor to click the Field you would like identified, 
          and a description of the field will pop up

To enter information into any of these fields:

1.      Click the field to place the cursor inside the field
2.      Type in the data

1)      Name of this Item:
This field simply gives you a place to identify the Item.

2)      Description:
This space holds your description of the Item, from the measurements of a coffee table to the 
materials used in manufacturing your candelabra. 

3)      Serial Number:
This field lists the serial number, if such exists, of the Item.

4)      Quantity:
This field holds the number of one Item that happens to come in groups, sets, or large numbers. 
For example, let's say that your conference room is filled with framed photographs of your 
company's award winning engineering designs. As the frames will not need to be itemized by 



serial numbers, you can group all ten of them together in one Item Form.
Note:

If you specify a quantity larger than 1, make sure that the price and present value are 
"each".

5)      Manufacturer:
This space identifies the company or organization that manufactured the Item, such as "Jason's 
Custom Saddles", "Super Tees Unlimited", or "Timeless Clock Designs". 

6)      Model:
Here, you can pinpoint the model of the Item, such as "Show Harness 1-34" or "Grandfather Wall 
Model 9c".

7)      Extra Fields 1 and 2:
Once again, the specifics of these fields are up to you! They can be renamed or customized to 
hold any Item data requiring its own field in the database. (To make your changes, select 
Database Tools from the Tools menu.)

8)      Purchase Price:
In this slot, you list the price you originally paid for the Item.

9)      Present Value:
This field can save the figure designated as the market value, current value, or estimated 
replacement cost of the Item.

10)      Taxable/Non-Taxable:
Flags Items as Taxable or Non-Taxable for report and accounting purposes. (Remember, the 
template of a "Home" or "Business" inventory defines the default setting for these classifications 
for a particular database.) 

11)    Purchased From:
This field holds the name of the store, person, or entity from which/whom you purchased the Item.

12)      Purchase Location:
This space retains the name of the city, state, and/or country of purchase.

13)      Date of Purchase:
The date you purchased the Item; often a critical point in settling insurance claims or 
documenting warranty durations. (Click the button of this field to call up a calendar and select the 
date.)

14)      Original Invoice #:
This field files the invoice number allocated to the Item at the time of purchase: an important proof 
of purchase for insurance procedures and warranty disputes.

 
15)      Category:

This field designates the Category under which that Item belongs: for example, your "SoftBristle 
E-Z Glide Sash Brushes" could fall under the "Specialty Paint Equipment" Category in your 
construction business. 

Every one of your Items can be assigned to Categories right from this field. To specify the 
Category of an Item, select one of the Categories you've already created from the roll-down list of 
this field or click the Add Category button to make a new one.

16)      Location Tree:
Presenting a list of all the Locations you've created, this Tree makes it easy for you to instantly 



place an Item in its proper Location. If the list doesn't include the Location you'd like to specify, 
you can use the Add Location button to create a new Location directly from the Add an Item 
Form.

Button Options

Add Category Button:
A click on this button will call up the Add New Category Form, so that you can create a new 
Category for your Item directly from the Add New Item Form.

Add Location Button:
You can create a new Location for your Item at the same time you add the Item to your Inventory 
from the Add New Item Form. Clicking this button allows you to name the new Location and 
place it where you'd like it to reside in the Location Tree. 

Display Icon Button:
Clicking this button loads the Icon Browser, which invites you to select or change the Item Icon 
displayed in the Inventory Explorer. (See the Icon Browser section for complete instructions.) 

Save Button:
Tells the program to store all the Item information you've provided, as well as the Item's icon and 
photo. Your Item is now part of your Inventory!

Cancel Button:
Cancels the Add an Item operation any time you wish.

Right about Now...

Your Listview is beginning to look something like this:

Moving On...

Now that you've found out how easy it is to set up your basic Inventory, you're probably eager to start 
exploring the options in Customizing an Inventory! On the other hand, if you'd like to experiment a little 
more with the Find, Photo Editor, and Listview features, check out the next chapter,  Fiddling Around 
With Specialty Features!  



Opening a database
As soon as you create your first database or begin working with more than one, you'll need to be able to 
open any database you've generated. 

To Open a Database:

1.      Click Open on the Toolbar.
2.      In the Look In box, click the drive that contains the document.
3.      In the folder list, double-click folders until you open the folder that contains the database.

For more information on items in the dialog box, click the question mark at the top of the dialog box, and 
then click the item.

A few Notes on opening Databases...

· To open one of the last several databases you had open, on the File menu, click the file name.
 
· Asset Inventory can automatically open the last used database when Asset INventory starts. 

Enable this option by checking the Automatily open last used database on startup 
checkbox.



Icon Browser Delights
Icons give your inventory that picturesque quality a thousand words can't match, so the Asset Inventory 
98 Icon Browser offers several hundred icons you can choose from to display in your    Inventory Explorer. 
Summon The Icon Browser from any Add or Edit Form merely by clicking the Display Icon button. 

Select special Icons from the Browser for any Location, Category, or Item to give yourself a visual aid to 
tracking the particulars of your inventory. You can even import as many of your own icons as you like by 
clicking the Add Icon button. (But please see the note below first.)

To Select an icon from the Browser:

1.      From the Alphabetical folders shown, select the first letter of the type of Icon you'd like to 
use. For example, select C to view an assortment of Camera, Car, or Curling Iron Icons.

2.      Click the icon you would like to use
3.      Click OK.

The Note about Custom Icons...

Default Icon

If you add custom (your own) icons to Asset Inventory 98, some non-detrimental side affects 
may occur. Because Asset Inventory 98 pulls the display icons from your icons directory, adding 
custom icons can cause Inventory Explorer to resort to using the default icon if, for some reason, 
the Items icon is missing. Therefore, we recommend that you do not add custom icons to Asset 
Inventory 98 if you will be accessing databases on other machines or from a network. Doing so 
will cause icons to show up as the default icon (above) on workstations that do not have a copy of 
the custom icon. 

Although enjoyable visual tools, icons perform no programmatic function in your inventory. 
Subsequently, icons don't need to be stored in your database file, making it easier to keep your 
files streamlined. 



Locations vs. Categories
As you enter data into your inventory, you'll assign every Item a Location and a Category. Sometimes 
you'll need to check what you have in a particular Location; other times, you'll want to see everything in a 
specific Category. To view different aspects of your inventory, you can change views in a couple of ways:

To Change Treeviews:

1.      Open the View menu 
2.      Choose either By Location or By Category

OR

·       Click the Locations bar at the top of the Treeview to view Locations
·       Click the Categories bar at the bottom of the Treeview to view Categories 

The type of information you need usually determines whether you approach your inventory by Category 
or by Location.

For example, let's say that, as the band director for the school district, you couldn't    store all of your 
rental instruments in one place and had to parcel them out to various storage areas in several different 
schools. Now that the school year is almost over, you have to account for them. 

If you have to give every principal a list of the instruments stored at his or her school, a glance in the 
Location View would look like the above example. By flicking through different Locations, you would see 
that Eastside Elementary has four violins, eight cellos, and a tuba. Hawthorne Elementary has two 
clarinets, nine flutes, and a tuba.    Jefferson Elementary stores three trumpets, a drum set, and a tuba. 
(Actually, there used to be two tubas at Jefferson, until that unfortunate accident involving the tether ball 
in May.)

You print a report for each principal, and everybody's happy!

In the Categories scenario, the Superintendent wants a total of all the instruments the District owns, no 
matter where they might be. Scoping out your Categories View, you would see 17 violins, 20 trumpets, 8 
saxaphones, three tubas (and one unidentified piece of twisted brass that might be what's left of the 
fourth.) Print the report, and you're done!



Listview Tricks
You already know the Listview of your Inventory Explorer shows you the details of your Locations and 
Categories, but it can also be changed to highlight the details of your details!

To Change the Outlook of your Listview:

1.      Click to open View in the Menu Bar
2.     Select Details from the options

The Listview immediately presents a detailed list of information concerning the items in your Locations 
or Categories.
 

If you'd like to make the Icons in your Listview smaller or larger, you can do that, too.

To resize Icon appearance:

1.      Click to open View in the Menu Bar
2.     Select Large or Small Icons from the options

Selecting either the Arrange or Line Up option in the View menu even lets you design a new display 
method for your Icons. So you can experiment with all the Listview do's until you get exactly the look you 
want!

To rearrange Columns while in Detail view:
1.    Simply click and drag a column header where you want it.



Photo Editor FX 
Not surprisingly, it's the Photo Editor's job to store photos of your Items and Locations. Click the Photo 
Tab on any Add or Edit Form and the Photo Editor Window pops up on your screen: 

Please be advised that certain optional devises are required to use this feature.    In order to scan 
photographs, you must have a TWAIN compatible scanner connected to your computer.

However, once your scanner is connected and functioning properly, using the Photo Editor is a snap! So 
(as soon as you finish groaning at that bad pun), you can scan, import or optimize your photos just by 
following these steps: 

To Scan a Photo:

1.      Select the TWAIN Source by choosing Select TWAIN Source from the Photo Editor's File 
menu

2.      Click the Scanner icon on the Photo Editor's Toolbar or click Scan Image from the Photo 
Editor's File menu

As you can see in the example below, TWAIN will launch your scanner's software to scan the photo, 
which then appears in the Photo Editor!



To Import Photos from a Disk:

1.      Click the Open button on the Photo Editor's Toolbar or select Open Image from the Photo 
Editor's File menu 

2.      Select the photo you want to open

Smile! Your selection's appearing in the Photo Editor!

To Optimize Photos:

The Photo Editor allows you to enhance colors, change sizes, or otherwise alter the appearance of 
your image by selecting from the options available in the Image menu. Just experiment with these 
options until you're happy with the look of your pictures.

One more Look at your Photos:

Nothing identifies your Items or Locations like a picture, but as every model knows, "the camera adds 
ten pounds"! Storing photographs adds bulk to your database, so we recommend you crop your photos, 
scanning only the important features of each, to create less data for Asset Inventory 98 to save. 

As cropping is performed by your scanner's software, refer to your scanner's literature for more 
information about this procedure.



Lose Something?
Working with inventory means working with hundreds or even thousands of Items, plus their associated 
Categories and Locations. When one of these gets lost in the shuffle, you can ask Asset Inventory 98 to 
run it down for you by using one of the following methods.

To Open the Find Window

From the Menu 

1.      Click Find in the Inventory Menu
  
With the Mouse

1.    Click Find on the Toolbar

With a Keystroke

1.    Press Ctrl+F

The Find Window appears to take down all the information it needs to locate your missing information: 

Tab Views

Clicking the appropriate Tab tells Asset Inventory 98 to hunt by Items or Locations, look only through 
Taxable or Non-Taxable classifications, or simply search everywhere for what you're missing. When the 
Item or Location is found, it is listed in the Find Window. In the above example, the Find Feature found 
two matches to the topic CDs. 

To Locate Lost Articles:



1.      In the Search For field, type all or part of the information you want to find
2.      If you can't or don't want to search by the name of the Item or Location, or if you want to 

refine the search, choose a different search option by clicking Search By 
3.      Click Find Now

Options for Narrowing your Search:

· Exact Match
If a near miss isn't going to help, click the Exact Match box. Asset Inventory 98 will use 
this search criteria to eliminate Items or Locations that don't exactly match your 
description.

· Edit Locations when clicked
This feature will load the Edit Form of any Location you click.

· Expand Locations when clicked
A click on this option closes the Find Window and commands the Inventory Explorer to 
browse to any Location you click.

· New Search Button
If you suddenly think of another clue you could give Asset Inventory 98, or if you've found 
one missing piece of a puzzle and need to track down the rest, clicking the New Search 
button lets you start over.

· What's This? Button
Like always, the What's This? button offers you a shortcut:
 
1.      Click the What's This? button in the right bottom corner of the window, and a 

question mark will materialize to the right of your cursor.
2.      Use the What's This? cursor to click the Field you would like identified, and a 

description of the field will pop up.

As it searches, the Find Feature may discover Locations, Categories, or Items which have been 
deleted. These deletions appear on the Find Window list with ghosted Icons.

Special Operations in the Find Feature

The Find Feature allows you to perform a variety of different operations right from the Find Window. You 
can:

· Edit a Location, Category, or Item 
Moving to the Find Window list, click the Location, Category, or Item you'd like to 
revise. Instantly, the proper Edit Form will appear to let you make your changes.

· Show Report Preview 
Clicking this button causes the Preview Window to pop up, so that you can take a look 
at what a report will look like in print before you print it. (The Preview Window features in 
Find are identical to the Preview Window features in Reports. See Working with 
Reports for more information.)

· Page Layout
Clicking this button will open the drop down menu which lists all the different ways you 
can organize reports. In the example above, Item Detail Report has been selected, but 



you can also report on Locations or Categories. (See Working with Reports for more 
information.)

· Customize
Clicking this button gives you the array of choices you have in selecting what information 
you want to include in the report about the Location, Category, or Item. In the above 
example, the report has been arranged to include information on the manufacturers, 
models, and serial numbers of the CDs. (See Working with Reports for more 
information.)

  
· Drag & Drop

If, for example, you finally found all your scuba gear accidentally shoved into the toy box, 
or your bathroom inexplicably moved into the garage, you can click Items or Locations 
you'd like to rearrange, and continue to hold the mouse button down as you drag 
your selection out of the Find Window onto the Inventory Explorer. If you drop the 
object(s) onto a Location, the object(s) are moved to that Location. Drop the object(s) 
onto a Category, and the object(s) Category is changed.



Overview
Your home and business inventory needs are unique, and you'll want the design of your inventory 
program to fit those special needs like a glove. 

We want that, too, so we've loaded Asset Inventory 98 with customizing features tailor-made for you. So 
go ahead; add, edit, and revise your Locations, Categories, and    Items any way you please! We help with 
the alterations in the sections below. 



Duplicating Techniques
Sometimes, you'll have several Locations or Items that are exactly alike...almost. For example, let's say 
you own four rental townhomes built at the same time to the same specifications by the same contractor, 
so they're identical...except for their addresses. Or perhaps each of the nine offices in your landscaping 
company is equipped with the same type of phone... except each phone has a different serial number. Not 
to mention the fact that your linen closet is stacked with dozens of the very same queen sized 
sheets...except three of the sets are striped.

When you've got a bunch of the same Locations or Items with only one or two differences, and you'd 
rather not fill out twenty New Forms with the same information, you can duplicate the repetitive Item or 
Location as often as you want and save a lot of time:

To Duplicate an Item or Location: 

1.      Click the Item or Location you'd like to duplicate
2.      Open Inventory in the Menu Bar
3.     Click Duplicate to clone your original Item or Location

Once you've duplicated the original, you can click on any of your clones, open an edit form, and make the 
few changes you need! 



Renaming Techniques
When a new name is the only change you want to make to a Location, Category, or Item, you don't 
need to move into any of the editing forms. Merely pick one of the following techniques:

To Rename A Location, Category, or Item:

From the Menu

1.      Select the object to be renamed    from either the Treeview or the Listview
2.      Click Inventory on the Menu Bar
3.      Click Rename

With the Mouse

1.      Select the object to be renamed from either the Treeview or the Listview
2.      Click Rename on the Toolbar

With a Keystroke

1.      Select the object to be renamed from either the Treeview or the Listview
2.      Press Ctrl+R

Any of the above methods call up an editing box which surrounds the Location, Category, or Item you've 
specified. Your cursor automatically places itself in the box, preparing you to type in the new name. Click 
outside of the editing box, and your newly christened Location, Category, or Item is saved.

One more thing you should know about renaming...

Renaming is a surface function that doesn't alter any other data in your database. So if, for example, you 
have nine spiked collars, four doggie shampoos, and six four-legged sweaters in a Category called "Dog 
Junk", all those Items stay in that Category even after you rename it "Exclusive Canine Accessories".



Editing a Location
Let's assume you moved, expanded, or otherwise remodeled one of your Locations, and need your 
database to reflect that Location's new look. No problem! Just use one of the following techniques: 

To Edit a Location:

From the Menu

1.      Select your Location from either the Treeview or the Listview
2.      Click Inventory on the Menu Bar
3.      Click Edit

With the Mouse

1.      Select your Location from either the Treeview or the Listview
2.      Click Edit on the Toolbar

With a Keystroke

1.      Select your Location from either the Treeview or the Listview
2.      Press Ctrl+E

You can make changes to your Location directly in the Edit A Location Form that appears on your 
screen:

Now, if you're thinking you've been here and done this, you're almost right! The Edit a Location Form 
does look exactly like the Add A New Location Form. Behind the scenes, the two forms function 
differently to organize your inventory, but the similarity of their formats means you won't have to wander 
around trying to find the information you need to edit! 

Tab Views



The General Tab 
The Edit form presented in the General Tab View contains all the same spaces you used 
previously for the basic information concerning your Location. In this form, you can revise or 
delete any or all of the information you'd like. 

The Notes Tab
You may have already used this area as your own computerized scratch pad for writing down 
information that concerns a Location, and now you need only click this tab to pull up that 
information for revisions, additions, or corrections.

The Photo Tab

Click this tab for direct access to the Photo Editor , which helps you scan and store a photo of the 
Location. (Certain accessory devices are required to use this feature. Check the Photo Editor 
section for details.) After you scan a snapshot of your Location, you'll find the picture under this 
tab. 

Description of Fields on the Edit A Location Form

In case you need a refresher course on the fields, the descriptions are listed below. But if most of these 
fields are familiar and you just want to take the shortcut:

1.      Select Help from the Form Menu
2.      Click the What's This? option, and a question mark will materialize to the right of your cursor
3.      Use the What's This? cursor to click the Field you would like identified, 
          and a description of the field will pop up

To enter information into any of these fields:

1.      Click the field to place the cursor inside the field
2.      Type in the data

1)      Name of this Location:
This simply gives you a place for the name of this Location.

2)      Description:
You can enter any brief description of the Location in this field, from the types of siding used in 
manufacturing to the floral pattern of the upholstery.

3)      Serial Number:
This field holds the serial number, if such exists, of the Location.

4)      Quantity:
This field is not available for Locations.

5)      Manufacturer:
Here, you can identify the company or organization that manufactured the Location, such as 
"Derby Queen Concession Stands, Incorporated", "Playworld Palace", or "Gizmo Garden Sheds". 

6)      Model:
This slot lets you specify the model of the Location, such as "TykeToy Swingset 67-98" or 
"Greenthumb Metal A-2 with sliding door option ".

7)      Extra Fields 1 and 2:



Once again, it's your choice! Rename or customize these fields to hold any data you consider 
necessary by selecting Database Tools from the Tools menu.

8)      Purchase Price:
In this field, enter whatever price you originally paid for the Location. 

9)      Present Value:
This field holds the figure, sometimes called Market Value, that reflects the current value of the 
Location.

10)      Taxable/Non-Taxable:
These classes designate Locations as Taxable or Non-Taxable for report purposes. Change as 
needed! 

11)    Purchased From:
This field holds the name of the store, person, or entity from which/whom you purchased the 
Location.

12)      Purchase Location:
This field identifies the city, state, and/or country of purchase.

13)      Date of Purchase:
This field remembers the date you purchased the Location in case you need it later for insurance 
claims or warranty verifications. (Clicking the button of the field itself calls up a calendar to let you 
select the date.)

14)      Original Invoice #:
Here, you can enter the invoice number allocated to the Location at the time of purchase: a 
critical proof of purchase often necessary in insurance disputes or warranty issues. 

15)      Category:
This slot retains the Category in which you consider that Location a member: for example, an 
"Office" Location in your home might fall into the "Cottage Industry" Category. 

Once again, you can create every one of your database Categories in this field. Select one of the 
Categories you've already created from the roll-down list of this field or click the Add Category 
button to make a new one.

16)      Location Tree:
Presenting a list of all the Locations you've created, this Tree makes it easy for you to instantly 
place the new Location in the tree where you want it. If the list doesn't include the Location you'd 
like to specify, you can create a new Location directly from the form.

NOTE: The location that you are editing will not show up in the Location Tree. 

Button Options

Add Category Button:
A click on this button will call up the Add New Category Form, so that you can create a new 
Category the minute you need one, right from the Edit A Location Form.

Add Location Button:
You can actually create other new Locations even as you revise one on the Edit A  Location 
Form. Clicking this button allows you to name a new Location and place it where you'd like it to 
reside in the Location Tree. 



Display Icon:
Click this button to load the Icon Browser and select or change the Location Icon displayed in 
the Inventory Explorer. (See the Icon Browser section for complete instructions.) 

Save Button:
Tells the program to store your revisions to the Location information, including the icon and 
photo. Your edited version is now in place!

Cancel Button:
Cancels the Edit A Location operation any time you wish.



Editing a Category
By now, you know the drill, so you can whiz through the following techniques:
 
To Edit a Category:

From the Menu

1.      Select your Category from either the Treeview or the Listview
2.      Click Inventory on the Menu Bar
3.      Click Edit

With the Mouse

1.      Select your Category from either the Treeview or the Listview
2.      Click Edit on the Toolbar

With a Keystroke

1.      Select your Category from either the Treeview or the Listview
2.      Press Ctrl+E

You can now make changes to your Category in the Edit Category Form that appears on your screen:

As you might recall, you click the desired field to type in the new information. Clicking the Change Icon 
button calls up The Icon Browser to give you a view of the different icons you can give your edited 
Category. When you're happy with your revisions, click Ok to save them. Any time you want to stop the 
editing process, tapping    Cancel returns you to the program. As always, you can get assistance using 
the What's This? cursor. 



Editing an Item
As your inventory Items will probably change more rapidly than your Locations or Categories, we've 
made it easy to revise individual articles by once again offering any of the following methods:

To Edit an Item:

From the Menu

1.      Select the Item from either the Category or Location View 
2.      Click Inventory on the Menu Bar
3.      Select Edit 

From the Listview 

1.      Right-Click the Item in the Listview 
2.      Select Edit

With the Mouse

1.      Select the Item from either the Category or Location View
2.      Click Edit on the Toolbar

With a Keystroke

1.      Select the Item from either the Category or Location View
2.      Press Ctrl+E

And (deja vu all over again!) the Edit Inventory Item Form below appears on your screen:

Tab Views



The General Tab 
The form presented in the General Tab View contains all the basic information you've already 
provided concerning an Item. Merely click on the field you want to change and start typing! 
Because the Edit Inventory Item Form matches the Add Inventory Item Form exactly, you 
don't have to learn anything new to get in and change your Items.

The Notes Tab
Rather than scribbling your concerns about an Item on the back of an old envelope, you jotted 
them down here! So instead of getting lost, trashed, or left in your pocket and thrown in the 
washer, all your previous notes on an Item, from remarks concerning the last time you had it 
repaired to the name of the Canadian boutique which had a matching item on sale, have been 
stored in this handy scratch pad, where you can add, revise, or erase information.

The Photo Tab
Click this tab for direct access to the Photo Editor , which helps you scan and store identifying 
photos of your Items. (Certain accessory devices are required to use this feature. Check the 
Photo Editor section for details.) After you scan a snapshot of your Item, you'll find the picture 
under this tab. 

Description of Fields on the Edit Inventory Item Form

For the crash course on any particular field, take the shortcut:

1.      Select Help from the Form Menu
2.      Click the What's This? option, and a question mark will materialize to the right of your cursor
3.      Use the What's This? cursor to click the Field you would like identified, 
        and a description of the field will pop up

To enter information into any of these fields:

1.      Click the field to place the cursor inside the field
2.      Type in the data

1)      Name of this Item:
This field merely holds the name you choose to identify this Item.

2)      Description:
Here, you can type in any brief description of your Item, from geometric patterns to fragrance 
choices. 

3)      Serial Number:
This area retains the serial number, if such exists, of the Item.

4)      Quantity:
The number you enter in this field is the quantity you might have of one particular Item; works 
well with any Item that comes in large quantities or sets. For example, if your cedar chest is 
packed with the fourteen plastic lobsters you use as decorations for your annual clam-bake, you 
can list the quantity without having to give each crustacean its own Item designation. 
Note:

If you specify a quantity larger than 1, make sure that the price and present value are 
"each".

5)      Manufacturer:
This field identifies the company or organization that manufactured the Item, such as "Jenson's 



Orthopedics", "Breezy Day Ceiling Fan Makers" or "Scuba Gear Design and Construction". 

6)      Model:
Here, you can specify the model of the Item, such as "Adjustable Backbrace 4K with Sponge 
Padding " or "Deep Sea Diver Tank #450".

7)      Extra Fields 1 and 2:
The use of these fields is still up to you! Rename or customize them to include any Item data 
needing a little space in the database. (To make your changes, select Database Tools from the 
Tools menu.)

8)      Purchase Price:
This field remembers the price you originally paid for the Item.

9)      Present Value:
This field retains your estimate of the market value, current value, or replacement value of the 
Item.

10)      Taxable/Non-Taxable:
Tags Items as Taxable or Non-Taxable for business purposes. (The template of a "Home" or 
"Business" inventory defines the default setting for these classifications for a particular database.) 

11)    Purchased From:
This slot holds the name of the store, person, or entity from which/whom you purchased the Item.

12)      Purchase Location:
In this field, you can list the city, state, and/or country of purchase.

13)      Date of Purchase:
This field lets you circle the date you purchased the Item, in case of warranty or insurance needs. 
(Click the button of this field to call up a calendar and select the date.)

14)      Original Invoice #:
This field keeps the invoice number allocated to the Item at the time of purchase, in case you 
ever need a proof of purchase for insurance claims or warranty problems.

15)      Category:
Here, you can designate the Category under which that Item belongs: for example, "Four Carat 
Diamond Dewdrop Earrings" would definitely qualify for the "Good Jewelry" Category.

You can assign Categories to every Item right from this field. To specify the Category of an Item, 
select one of the Categories you've already created from the roll-down list of this field or click the 
Add Category button to make a new one.

16)      Location Tree:
Whether you've rearranged the whole house, or reorganized your office, Items shift around from 
Location to Location. You can make the switch here simply by clicking the desired Location, or 
creating a new one. 

Button Options

Add Category Button:
A click on this button will call up the Add New Category Form, so that you can create a new 
Category if you need one for the Item you're revising on the Edit an Item Form.

Add Location Button:



You can make a new Location for the Item you're changing on the Edit an Item Form or simply 
create a New Location you might need later. Clicking this button allows you to name your new 
Location and place it where you'd like it to reside in the Location Tree. 

Display Icon Button:
Clicking this button loads the Icon Browser, which you'll need if you want to change the Item Icon 
displayed in the Inventory Explorer. (See the Icon Browser section for complete instructions.) 

Save Button:
Tells the program to store all the new Item information you've provided, as well as the Item's 
latest icon and glamour photo. Your revised Item is now safely stored in your inventory!

Cancel Button:
Cancels the Edit Inventory Item operation any time you want to quit.



Building the Basic Report
Mix and match Asset Inventory 98's report options, and you'll find you can customize almost any kind of 
report for your inventories. We've built in dozens of optional combinations that seem to breed new 
optional combinations like rabbits, multiplying the possibilities geometrically until you literally have 
thousands of potential ways to design a report. 

But you don't have to try to memorize each and every combination, because your nearly unlimited range 
of choices springs from just a few fundamental operations. Once we give you the basics, you're on your 
way! Begin with the following steps:

To Create a Basic Report:

From either the Listview or Treeview, select a Location, Category, or Item as the subject for the 
report , then:

From the File Menu

1.      Select Build Report 

With the Mouse

1.      Click Reports on the Inventory Explorer ToolBar
2.      Select Build Report 

The Reports Window will appear:

Click the arrow by the Select Report field, and the following menu of report options drops down:

Report Styles
 

· Location Contents
Choosing the Location Contents report will create a report detailing all the Items of the 
Location selected as the original subject. You may specify the layout options of the 
report by clicking the Customize button.

· Report by Category
Choosing the Report by Category creates a report which accounts for all the Items of 
the Category selected as the original subject. You may specify the layout options by 
clicking the Customize button.

·     Item Detail Report



Choosing the Item Detail Report creates a report which details the particulars (such as 
the quantity, manufacturers, and serial numbers) of every Item in the inventory. You may 
specify the layout options by clicking the Customize button.

· Item Report (with Photos)
Choosing the Item Report (with Photos) creates a report which details the Item selected 
as the original subject, and displays the picture of the Item as it appears in the Photo 
Editor. The layout options are pre-set for this feature and can not be revised.

· Location Report (with Photos)
Choosing the Location Report (with Photos) creates a report which details the 
Location selected as the original subject, and displays the picture of the Location as 
it appears in the Photo Editor. The layout options are pre-set for this feature and can 
not be revised.

In the example below, Location Contents has been selected as the report method for a conference 
room. The Report Window will change depending on the report method you've chosen, so you might 
want to take a look at all the methods before deciding on one.

In the event you are perfectly happy with a report and have no revisions to make, you can:

· Review the report page by page by using the up and down arrow keys to the left of the page 
number field 

OR

· Click inside the Browser's Report Window to generate a helping hand that moves the pages 
for you when you hold the button of your mouse 

· Zoom in and out of the report by using the + or - magnifying glasses or scrolling through the 
menu

· Save your file by clicking Save in the Report Window's File Menu 



· Print by clicking the Print button

However, perhaps there are a few things about the report you'd like to change. In Customizing a Report, 
you'll learn how to give a basic report a whole new look.

By the Way...

Don't miss the special Export Option available in the Report Window's File Menu! It will save a copy of 
the entire report, then let you:

· Print your entire report on the Internet by employing the Adobe Portable Document Format    
(.PDF) 

· Convert your report to Word by employing the Rich Text Format (Microsoft Word) 



Customizing a Report
Clicking on the Customize button in the Report Window calls up the Customize Report Window, like the 
one pictured below.

In this example, a Locations Contents Report has been selected for customizing, although the other 
report layouts can also be modified, with the exception of those including scanned photos.

As seen in the example, under the Location name are four fields that hold specifics about the Location. 
The Present Value and Purchase Price are pre-set fields in this report, but the other fields are open to 
revision. Presently, the example fields have been set to Manufacturer, Model, Serial Number, and Original 
Invoice Number, but that could change the minute you decide you need Notes, Descriptions, and the Date 
of Purchase in the report.

Directly under the Location information are the fields that allow you to select the type of information the 
report will present about your Items.

The quantity (Qty) is pre-set in the example, but the other five fields can be arranged to show whatever 
information you provided on the Add/Edit Form for that Item, in whatever order you'd like to see. 

For example, you could specify that the above fields identify the manufacturer and model of the Item 
before the name,    or you could choose entirely new classifications from the options for every field.
 
To Customize a Field:

1.      Click the arrow to the right of the field to open the menu list 
2.     Click the type of information you want to appear in the field 
3.     Click the Save button

Once you've saved your custom options, you can close the Customizing Window and return to the 
Report Window.

A Word or Two about Customizing...

If, after experimenting with rearranging the fields, you decide you liked the original settings, you can bring 
them back by clicking the Reset Default button.



In the event that you could use two more columns of information, click the Click to see more Report 
Fields box.

You can print your new report using the steps laid out in Printing Your Reports. 



Reporting while Browsing
Let's say you're scrolling through the Treeview or clicking around in the Listview, when it occurs to you 
that it would be great to see what a report would look like for one of your Locations, Categories, or 
Items. You can get a quick glimpse while you're browsing through your inventory by using any of the 
following techniques.

To Report While Browsing:

From the Menu Bar:

1.      Click Inventory 
2.      Select Report while browsing

From the File Menu:

1.      Select Report while browsing

With the Mouse:

1.      Click Reports on the ToolBar
2.      Select Report while browsing from the options in the menu 

In the Listview:

1.      Right-Click in the Listview Window
2.      Select Report while browsing

All these methods serve to call up the Browsing Reports Window:

Containing many of the same features as the Report Window pictured in Creating the Basic Report, 
the Browsing Reports Window lets you select a report style from the Page Layout and customize the 
layout with the Customize button. And you can still:

· Review the report page by page by using the up and down arrow keys to the left of the page 
number field 

OR

· Click inside the Browser's Report Window to generate a helping hand that moves the pages 
for you when you hold the button of your mouse 

· Zoom in and out of the report by using the + or - magnifying glasses or scrolling through the 
menu

· Save your file by clicking Save in the Report Window's File Menu 



· Print by clicking the Print button

· Click the Detach button and...surprise! The Browsing Reports Window breaks away from its 
docked position, so you can move it around to any location in your screen, then continue to 
view your report, or even print it. However, once you Detach the Report while Browsing 
Window, you can no longer enter the Page Layout or Customizing options. 



Searching for Items/Locations to Report
Perhaps you need a report on a number of Items from various Locations, and want to be highly selective 
in what Items will be included. You can pick and choose by using Search for Items/Locations to report . 

To Search for Items/Locations to Report:

From the File Menu:

1.      Select Search for Items/Locations to report

With the Mouse:

1.      Click Reports on the ToolBar
2.      Select Search for Items/Locations to report from the options in the menu 

And you'll be immediately presented with the Find Window:

In the Find Window, you'll be able to pick and choose your selections for reports, as well as perform 
operations such as:

· Show Report Preview

· Select Page Layout

· Customize a Report

· Zoom in and out of text

· Detach the Report Preview Window 

For more information about your Find Window, please see Searching for Items or Locations.



Printing Your Reports
If you've been watching closely, you might have noticed that you can print reports from any of the Report 
Windows in Asset Inventory 98, including the Find Window, just by clicking the Print button like the one 
on the screen seen below.

To Print a Report:

From the Menu Bar:

1.      Click Inventory 
2.     Click Print or Print Preview

The Print Options Window will appear to let you choose from the basic printing choices.

If you'd like to see a quick overview of the contents of your report before you print it, just click on the 
Table of Contents Button at the left of the Toolbar and scroll down the list!



Backing up the Database
A backup copy of your database may one day be the only thing standing between you and utter 
devastation.    Protect yourself from loss, theft, or damage by backing up your databases on a regular 
basis and storing the backups in a safe place (off site storage is strongly recommended). Then, in the 
event of a disaster, you will be able to recover your inventory information.

To Back up a Database:

1.      Select Database Tools from the Tools menu 
2.      Select Backup Database from the options to summon the Database Backup 
            Wizard, as seen in the below example
3.      Choose a Backup Set by selecting Browse
4.      Click Backup to continue the operation

To Automatically prompt for backup on Exit

1.      Select    Options from the Tools menu
2.      In the options window, click the box to the left of Automatically prompt for backup on
            exit to tell Asset Inventory 98 to remind you to backup before closing

Although Asset Inventory 98 compresses the databases when it stores them in Backup Sets, even 
compressed Backup Sets may actually become too large to fit on a normal floppy disk. Some other form 
of transportable media, such as zip files or backup tapes, may be required.



Restoring from a Backup Set
One of these days, a computer genius will come up with a foolproof safety device to insure that the need 
to restore a backup will never again present itself. (And one of these days, pigs will fly.) So when and if 
the situation does arise, the Database Restore Wizard will be right there to help you through the 
restoration process. 

To Restore from a Backup Set:

1.      Select Database Tools from the Tools menu
2.      Select Restore Database from the options to summon the Database Restore 
            Wizard, as seen in the below example
3.      Click the Browse button to select the Backup Set you would like to restore
4.      Click Next
5.      Click Browse to select where to put the restored file



Compacting a Database
Compacting a database allows you to reduce the file size of your database and save yourself a little hard 
drive space. 

To Compact a Database:

1.      Select Database Tools from the Tools menu
2.      Select Compact Database 

Asset Inventory 98 takes it from there.



Repairing a Damaged Database
In the event of a computer glitch or power outage, it is possible that your database may become corrupt. 
When this happens, Asset Inventory 98 allows you to attempt to repair the database. As no operation is 
guarenteed to restore a corrupt database, we can't make any promises...but we will keep our fingers 
crossed for you. 

To Repair a Damaged Database:

1.      Select Database Tools from the Tools menu
2.      Select Repair Database

Asset Inventory will notify you as soon as your database has been restored.



Product Suggestions
As with any software, continued and varied use of Asset Inventory 98 shows us that there is always room 
for improvement. And since our customers often have the best ideas,    if you notice a feature that could 
be enhanced, added, or otherwise changed to improve the functionality of the program, we'd love to hear 
about it! Drop Technical Support a line and let us know about your great idea!



Obtaining Technical Support
If you need assistance or have questions that have not been answered in the help file or manual, please 
feel free to contact us for more information.

Traditional:
Graffiti Software, LLC
2325 W. Broadway, Suite C
Idaho Falls, ID 83402-2948
TEL: (208) 523-6464
FAX: (208) 524-2623

E-Mail:
Support@graffitisoft.com

World Wide Web Support:
http://www.graffitisoft.com/support/



End-User Licensing Agreement
SHRINK-WRAP LICENSE

IMPORTANT:    DO NOT OPEN THE ACCOMPANYING SEALED MEDIA PACKAGE OR USE THE 
SOFTWARE UNTIL YOU HAVE READ AND AGREED TO THE TERMS OF THIS LICENSE 
AGREEMENT.    IF YOU DO NOT AGREE TO ABIDE BY THE TERMS OF THIS AGREEMENT, YOU MAY 
RETURN THE COMPLETE SOFTWARE PACKAGE TO YOUR DEALER FOR A REFUND WITHIN FIVE 
(5) DAYS OF PURCHASE, AS LONG AS THE SEAL ON THE MEDIA ENVELOPE HAS NOT BEEN 
BROKEN.

Licensee agrees, by its act of opening the sealed media package or its use of the Software, that Licensor's grant to Licensee of the 
right to use and possess this Software shall be subject to the following terms and conditions.

Definitions
The following definitions apply to this agreement:

(a) "Licensor" is Graffiti Software, LLC, the owner of the rights to the copyright on the Software.
(b) "Licensee" means the individual or the business entity that has purchased this package and a license to use the 

Software under the terms set forth in this license.    "Licensee" includes those persons in Licensee's immediate 
organization, such as business associates, partners and employees, who are authorized to use this copy on the 
Computer pursuant to this Agreement.

(c) "Computer" is the single microcomputer system, using a single processor or a co-processor, on which Licensee is 
licensed to use this Software.    Use on multiple CPU systems, networks, or emulations on mainframe or 
minicomputers are not covered under this license and require site licenses available from Licensor at additional cost.

(d) "Software" is the object-code computer program contained in the media enclosed in the accompanying sealed 
package.

(e) "Documentation" means the published User Manual for the Software provided with the Software.
(f) "License" means this License Agreement.
(g) "Registration Card" means the information card provided with the Software.

License
Licensor grants Licensee a nonexclusive right to install and use one copy of the Software on a single computer at a single location 
in accordance with the terms of this License.    Licensee may change the Computer on which Licensee is authorized to use the 
Software to another computer within Licensee's immediate organization only if the Software is no longer used on the former 
Computer.    Licensee owns only the magnetic or other physical media on which the Software is recorded or fixed.    Licensor retains 
ownership of the Software recorded on the original media and all subsequent copies of the Software, regardless of the form or 
media in or on which the original and other copies may subsequently exist.    This License is not a sale of the Licensee's copy or of 
any subsequent copy.    In the event Licensee violates any of the provisions of this License, Licensee agrees either to destroy or 
return the original and all existing copies of the Software to Licensor after receiving notice of Licensor's termination of the License.    
Licensor may immediately terminate this License, at any time, by notice to Licensee.    Licensee agrees to comply with the terms and 
conditions of this License and agrees to take all necessary steps to protect Licensee's software from theft or use contrary to the 
terms of this License.    Licensee agrees not to: create derivative works from the Software or disassemble, decompile, or otherwise 
reverse engineer the Software or use or attempt to obtain any techniques, algorithms, processes, trade secrets, or proprietary 
information contained in the Software.    Unless earlier terminated by Licensor in accordance with this agreement, this License shall 
be deemed effective from the date Licensee receives the Software and shall be valid only so long as Licensee uses or possess the 
Software.

Possession and Copying
Licensee agrees that the Software will only be displayed on, or read into, or used on, the licensed Computer.    Licensee agrees to 
make no more than one (1) copy of the Software for backup purposes only and to keep the original and backup copies in the 
possessions or direct control of Licensee.    Licensee agrees to place a label on the outside of the backup copy showing the program 
name and Licensor's copyright and trademark notices, in the same form as they appear on the original copy.    The transfer of a copy 
to one hard disk shall count as one backup copy.

Transfer or Reproduction
Licensee shall not rent, lease, transfer, network, reproduce, display, or otherwise distribute the Software except as specifically 
provided in this License.    Licensee may not transfer any copy of the Software to another person or entity outside Licensee's 
immediate organization, on either a permanent or a temporary basis.    Licensee understands that unauthorized reproduction of 
copies of the Software or unauthorized transfer of any copy of the Software may constitute a criminal offense and subject Licensee 
to suit for damages, injunctive relief, and attorney fees.

Limited Warranty and Disclaimer of Liability
Licensor has no control over the conditions under which Licensee uses the Software and does not and cannot warrant the 

performance or results that may be obtained by its use.    However, Licensor warrants that the Software, for a period of thirty 
(30) days from delivery, will operate substantially in accordance with the functional specifications set forth in the 
Documentation.    If, during the warranty period, the Licensee is not satisfied with the performance of the software, Licensee 



may return the Software (as delivered to Licensee), accompanied by the receipt, to Licensor for replacement or, if so elected, 
for a refund of the price paid for the Software.    Replacement or refund is the sole and exclusive remedy for breach of any 
warranties by Licensor.    THERE ARE NO OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULARE 
PURPOSE.    In no event shall Licensor be liable for any indirect, incidental, consequential, special, or exemplary damages, lost 
profits, or claims by third parties, even if Licensor has been advised of the possibility of such damages.    Licensor shall not be 
liable for any loss or damage exceeding the price paid for the Software.    Licensee shall indemnify and hold Licensor harmless 
against any claims, causes of action, damages, liabilities, or demands that stem from, or are related to, Licensee's use of the 
Software.

Media Replacement
For one (1) year from the date of delivery, the original media containing the software may be returned to the Licensor for 
replacement if it becomes damaged.    The damaged media must be returned to Licensor with the receipt and a media replacement 
fee of $10.00.    Promptly following receipt of the foregoing, Licensor shall replace the media, on an exchange basis, with the same 
or, at its sole option, an updated revision of the Software.

General Conditions
This License shall be governed by, and construed in accordance with, the laws of the State of Idaho.    The delay or failure of either 
party to enforce any of the provisions of this license shall not be construed to be a waiver of any right of that party.    The termination 
of this License shall not affect the provisions of this License, which by their terms and meaning are of a continuing nature.    This 
License sets forth the entire understanding and agreement between Licensor and Licensee with respect to its subject matter and 
merges any and all prior oral or written communications, advertising, discussions, proposals, purchase orders, agreements, 
communications, and representations between them.    Neither of the parties shall be bound by any conditions, definitions, 
warranties, or representations with respect to any of the terms or conditions in the Agreement other than as expressly provided in 
this License.    This License may only be modified by a written agreement.    If any provision of this License shall be held illegal, void, 
or unenforceable, the remaining provisions shall remain in full force and effect.    The paragraph headings in this License are for 
convenience only, form no part of this Agreement, and do not affect its interpretation.

Graffiti Software, LLC
2325 W. Broadway, Suite C

Idaho Falls, Idaho 83402 
Phone (208) 523-6464 

Fax (208) 524-2623



File Naming Conventions:
In order to make it easier to find documents, you can use long, descriptive file names. The complete path 
to the file, including the drive letter, server name, folder path, and file name, can contain up to 255 
characters. 

Keep in mind, however, that file names cannot include any of the following characters: forward slash (/), 
backslash (\), greater than sign (>), less than sign (<), asterisk (*), period (.), question mark (?), quotation 
mark ("), pipe symbol (|), colon (:), or semicolon (;).

Some "proper" filenames:

C:\Asset Inventory 98\My New Database.pid

\\adifferentmachine\sharename\directory\filename



Add Item Form

Name of this Item:
The name you would like to use to distinguish this Item.

Description:
A brief Description of the Item

Serial Number:
The serial number of the Item

Quantity:
Commonly used for item that come in large numbers. For instance, your office may have 20 cup 
holders and those cup holders do not have unique serial numbers, so you want to group them 
together.
Note:

If you specify a quantity larger than 1, make sure that the price and present value are 
"each".

Manufacturer:
The company or organization that manufactured the item ("Sony" for instance)

Model:
The model of the item (Honda "Accord")

Extra Field 1 and 2:
These fields can be renamed or "customized" to hold any data that you feel is needed and needs 
its own field in the database. You can customize these field under "Database Tools" in the Tools 
menu.

Purchase Price:
The price that you paid for the item when you bought it. If you enter a number larger than 1 in 
"Quantity" make sure the value for purchase price is "each".



Present Value:
Commonly known as "Market Value"; this field is used to store information about the current value 
of the Item. 

Taxable/Non-Taxable:
This is used mainly for business databases. It allows you to flag Items as "Taxable" or "Non-
Taxable" for report purposes. The default value is different depending on if the database was 
originally set up for "Home" or "Business" use. "Home" databases will default to Non-Taxable, and 
"Business" databases to Taxable.

Notes:
Used to store notes or any information you need.

Purchased From:
The name of the store, person, or entity from whom/which you purchased the Item

Purchase Location:
The city, state, country, or other place of purchase. This field is useful for tracking souvenirs.

Date of Purchase:
The date that you purchased the Item. This field is edited by clicking the Button or the field itself. 
When clicked a date selector appears to help you select the date.

Original Invoice #:
The invoice Number that the Item was purchased with. (Mainly used for business databases.)

Category:
The category to which the Item belongs. Click "Add Category" if the category you want the Item to 
be placed in does not exist in the drop down list.

Location:
The location of the Item. You will see the same location tree that is seen in the Inventory Explorer. 
You may add a Location by clicking the    Add Location button.

Display Icon:
Loads the Icon Browser allowing you to change the icon that is displayed in the Inventory 
Explorer. Customizing display icons makes Asset Inventory more visually appealing.

Item Photo:
Loads the Photo Editor which allows you to store a photo of the Item.

OK Button:
Stores the Item information including icon and photo.

Cancel Button:
Cancels the operation.



Treeview
The Treeview visually displays Locations and Categories from your database. Right-Click inside the 
Treeview for more options.



Categories Button
Click this button to view your Categories.



Locations Button
Click this button to view your Locations.



Listview
The Listview visually displays Items and Locations from your database. Right-Click inside the Listview for 
more options.



Display Icon
Loads the Icon Editor, which allows you to change the icon displayed in the Inventory Explorer. 
Customizing display icons makes Asset Inventory more visually appealing.



Item Photo
Loads the Photo Editor, which allows you to store a photo of the Item.



Location
Identifies the Location of the Item. You will see the same location tree that is seen in the Inventory 
Explorer. You may add a Location by clicking the "Add Location" button.



Category
The category to which the Item belongs. Click "Add Category" if the category you want does not 
exist in the drop down list.



Invoice #
The Invoice Number of the Item at the time of purchase. (Mainly used for business databases.)



Date of Purchase
The date on which you purchased the Item. This field is edited by clicking the Button or the field 
itself. When clicked, a date selector appears to help you select the date.



Purchase Location
The city, state, country, or other place of purchase. This field is useful for tracking souvenirs.



Purchased From
The name of the store, person, or entity from whom/which you purchased the Item.



Notes
Stores comments, remarks, notes, or any information you need.



Taxable/Non-Taxable
This is used mainly for business databases. It allows you to flag Items as "Taxable" or "Non-
Taxable" for report purposes. The default value is different depending on if the database was 
originally set up for "Home" or "Business" use. "Home" databases will default to Non-Taxable, and 
"Business" databases will default to Taxable.



Present Value
Commonly known as "Market Value", this field is used to store information about the current value 
of the Item. 



Purchase Price
The price that you paid for the Item when you bought it. If you enter a number larger than 1 in 
"Quantity", make sure the value for purchase price is "each".



Extra Fields
These fields can be renamed or "customized" to hold any data that you feel needs its own field in 
the database. You can customize these fields under "Database Tools" in the Tools menu.



Model
Identifies the model of the Item (Honda "Accord")



Manufacturer
The company or organization that manufactured the Item ("Sony" for instance)



Quantity
Commonly used for Items that come in large numbers. For instance, your office may have 20 cup 
holders and those cup holders do not have unique serial numbers, so you want to group them 
together.
Note:

If you specify a quantity larger than 1, make sure that the price and present value are 
"each".



Serial Number
The serial number of the Item



Description
A brief Description of the Item



Name
The name you would like to use to distinguish this Item.



Name of Category
The name of the category: cars, appliances, electronics, furniture.



Creation Date



Modification Date



Search Results



Search For
Provides a place for you to enter all or part of the information to search for. Leave this field blank to 
search for all Items or locations.



Edit/Expand Locations when clicked
This option sets the behavior of the Find Window when a location is clicked.

· Edit Locations when clicked
Causes the location edit form to load for the location that was clicked.

· Expand Locations when clicked
Causes the Find window to close and the Inventory Explorer to browse to the location that was 

clicked



Search    by
Specifies the information that Asset Inventory will search.



Exact Match
When this box is checked, Asset Inventory only returns Items or Locations that exactly match the search 
criteria.



Find items, locations tab
Allows you to search for Items or Locations 



Recently opened databases



Automatically open last used database on startup
Choosing this option causes Asset Inventory to open the most recently opened database automatically 
when Asset Inventory is started. This is helpful when you    use the same database often.



Find Now
Start the search.



Stop Search
Stops the Search currently in progress You maystop a search after it has begun.



New Search
Resets Search Criteria.



Automatically Prompt for backup on exit
This setting causes Asset Inventory to prompt you to backup your database when you exit. Helpful for 
making sure backups are done regularly.



Double-Click to open an item (Single-Click to select)
Specifies that you want to Single-Click a Item to select it, and Double-Click an Item to open it. This is the 
normal windows explorer behavior.



Save Toolbar Layout on exit
This setting causes Asset Inventory to save the position and docking of the Toolbar when the Application 
is closed and restore the saved setting the next time Asset Inventory opens.



Reset Toolbar Layout
Clicking this button causes Asset Inventory to delete the saved toolbar and reset it to the original setting.



Automatically Prompt for backup on exit
This setting causes Asset Inventory to prompt you to backup your database when you exit. Helpful for 
making sure backups are done regularly.



Automatically Backup to:
Sets the default folder used to store backup sets.

·  Click Default to reset the Default Backup Folder
·  Click Browse to Select the Default Backup folder



Single-Click to open as item (point to select)
Specifies that you want to select an Item without opening it by positioning the cursor over the Item and 
Single-Click an Item to open it. This is the typical behavior of modern web browsers.



OK
Closes this dialog box and saves any changes you have made.



Cancel
Closes this dialog box without saving any changes you have made.



Custom Fields
Asset Inventory will rename this custom field with the text you enter in this textbox.



Template Description
A brief description of the Template.



Template List
A list of the available templates. Double-Click a template to open it.



Report Preview Window
This window previews the selected report. Print the report by clicking the Print button.



Installing Asset Inventory 98
Installing

Because Asset Inventory 98 comes equipped with an Auto-Run install system specifically designed to 
work with Microsoft Windows 95 or Microsoft Windows NT Workstation 4.0 or higher, the program is a 
snap to add to your computer. Simply:

1.      Open your Windows environment
2.      Insert the Asset Inventory 98 CD into your CD-ROM disc drive
3.      In the resulting Autorun Window Click Install Asset Inventory 98. This will launch the 

InstallShieldâ wizard, which will guide you through the setup process
4.      Click Next
5.      Click the Yes button to accept the terms of the License Agreement OR click the No button to 

close the Install Setup. (Return the Asset Inventory 98 program to us if you choose to decline 
the terms.) 

6.      Accept the default location proposed to install the program    OR choose your own location 
and click Next.

7.      Asset Inventory 98 will then install. Once the files are copied to your hard drive, click Finish 

That's it!    Asset Inventory 98 automatically sets itself up, so you can begin building your inventory files! 

You may optionally install:
· Microangelo 2.1ä (Shareware version). An integrated suite of utilities designed specifically for icons, 

cursors and animated cursors. A true "Swiss Army Knife" of tools designed to master all aspects of 
these program and desktop elements for Windows 95 and Windows NT 4.0. This Suite can be used 
to create your own personalized icons or edit existing icons and in turn use them in Asset Inventory 
98. We encourage you to register Microangelo 2.1ä if you plan to use it on a regular basis.

· Adobeâ Acrobat Readerä Since Asset Inventory allows you to export your reports to "Adobe 
Portable Document" format, we have included this viewer from Adobeâ to allow you to view the 
exported files before distributing them over the Internet or other medium.

Please note that Graffiti Software has no control over the workings of Adobeâ Acrobat 
Readerä or Microangelo 2.1ä. If you experience problems with Adobeâ Acrobat Readerä or 
Microangelo 2.1ä, please contact the respective companies for support.

Uninstalling

Should you wish to remove Asset Inventory 98 from your Windows environment, the following steps allow 
you to uninstall the program at any time:

1.      Return to your Windows environment
2.      Click the Start button at the left bottom corner of the screen
3.      Select Settings from the menu list
4.      Click on Control Panel in the secondary menu
5.     Choose the Add/Remove Program option
6.      Select Asset Inventory 98 from your list of programs
7.      Click the Remove button
8.      Click the Yes button 

At this point, your computer may ask you if you wish to remove Shared Files. Unless you know exactly 
what those files contain and are willing to see them go, we strongly recommend that you choose to leave 
Shared Files installed. 




